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Chapter 1 Getting Started 

 

 Main Interface 

 
 

1. Quick Access Toolbar 
The Quick Access Toolbar is located in the upper left of the Excel screen, next to the Excel Logo. 
 
The Quick Access Toolbar is a part of the user interface that is used to store buttons or features 
that are relied on heavily. When features are added to the quick access toolbar, they can be 
brought into play with a single click, even when the associated Ribbon is unavailable. 
 

2. Ribbon Tabs 
This panel of buttons and controls is called a Ribbon. When one of the labeled tabs above the 
Ribbon (Home, Insert, Page Layout, Formulas, Data, Review and View) are clicked, buttons and 
controls in the Ribbon change according to the tab clicked on. 
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3. Program Title Bar 
The Program Title Bar displays the name of the program. At the left end of the Title Bar is the 
Office menu button for the Excel program. On the right end of the Title Bar are the Minimize, 
Maximize/Restore and Close Buttons. 
 

4. Columns and Rows 
The organizational scheme in a spreadsheet is a grid of rows and columns. Each of the rows is 
numbered and each of the columns is lettered. 
 

5. Cell/Cells 
A cell on the spreadsheet is the intersection of a row and a column.  The cell is the container or 
box that holds any data typed. Each cell is referenced first by the column and then the row, i.e. 
A1 or B5 or G12. 
 

6. Formula Bar 
The formula bar is made up of 3 areas. 

 The first area displays the cell location (A1).  

 The second area displays buttons: 
 

o To cancel the entry. 
 

o To complete or enter the information. 
 

o To assist in building functions.  
 

 The third area displays the cell contents. 
 

7. Chunks 
Each ribbon is divided into various parts called chunks. For example, the Page Setup chunk on 
the Page Layout tab contains all the commands needed to configure the page. 
 

8. Sheet Tabs 
Contains worksheets which are collections of cells on a single “sheet” where the data is 
manipulated. 
 

9. Scroll Bar 
The Status Bar displays the status of keys within the program as well as messages and prompts. 
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 Workbooks 

Excel has the ability to combine several sheets into a Workbook. The individual sheets in a workbook 
may contain diverse or related pieces of information.   

 

I. Creating a New Workbook 
Once Excel is opened, select a blank workbook or select a template from the list. 

To create a new workbook: 

 Open the Office menu by clicking the File button. 

 Select the New button. 

 Choose a blank workbook or a template from the list.    
 

II. Opening a Workbook 
There are several ways to open an existing workbook: 

 The simplest way is to navigate to an existing Excel workbook file and double-click on the 
icon. 

 Open the Office menu and choose a workbook from the Recent Documents list. 

 Click the Open command in the Office menu. Click Computer then Browse. An Open 
dialogue box will be displayed. Use this dialogue box to navigate to a location (directory). 
Open the workbook by first highlighting it in the dialogue box’s window and then clicking 
the Open button. 

 

III. Saving a Workbook 
To save a new, unnamed document: 

1. Choose the Save As option from the Office menu 
2.    In the File Name box, type a name. 
3. At this point choose a different drive and/or folder. 
4. Choose Save. 

Another way to save a workbook is to click the Save button   in the top left of the Excel screen 
or press Ctrl + S on the keyboard. 
 

 Getting Help 

Excel provides an online Help system. It includes reference information about using Excel as well as a 
step-by-step procedures, examples and demonstrations. The Excel Help Screen can be accessed by 
clicking on the question mark button in the upper right corner of the Excel screen. The Help Screen cab 
also be displayed by pressing F1 on the keyboard.  

 

 Quitting Excel 

To quit Excel, there are several ways to do so: 
1. Simply click the X in the upper right corner of the Excel screen.  
2. Open the Office menu in the upper left corner of the screen and click Close. 
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Chapter 2 The Interface 

 The Quick Access Toolbar 

The Quick Access toolbar is next to the Office menu. Frequently used 
commands can be stored here. By default, there are three icons on the 
toolbar: Save, Undo and Redo/Repeat. 

 
 
To add a button: 

1. Click the drop-down arrow on the toolbar. 
2. Choose any commands to add to the toolbar. 
OR 
1. Right-click any command on the ribbons. 
2. Click Add to Quick Access Toolbar.  

 
 

 The Home Ribbon 

 
 

1. Clipboard 
These buttons relate to cutting, copying and pasting items from one location to another. 
 

2. Font 
These buttons change a font’s type, size, color and style. 
 

3. Alignment 
The Alignment group controls how data (text or numbers) appears in spreadsheet cells. 
 

4. Number 
The Numbers group controls how numerical values are displayed in cells. In Excel, numbers can 
have different formats including normal, number, accounting, scientific, fraction, percentage, 
date and time. 
 

5. Styles 
The Style group allows for cell(s) to be styled quickly. There is also a conditional formatting 
control to quickly apply special color coding and other rules to cells conditionally (based on 
particular aspects or qualities of the data). 
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6. Cells 
The Cells group controls inserting, deleting and adjusting the size of a cell or group of cells.  
Clicking the small arrow on each button displays a menu of options corresponding to the button 
selected (insert, delete or format). 
 

7. Editing 
The Editing group provides quick access to some useful arithmetic features, filtering and sorting 
features and a search and replace feature.  
 

 

 Insert Ribbon 

 
 

1. Tables 
Tables apply functionality and formatting to a selection of data. 
 
The Pivot Table button will apply a pivot table to a selection of data. A pivot table will 
investigate relationships and dependencies in the data. 
 
The Table button will apply a standard table to the data. These tables can help organize, sort 
and filter data based on entered criteria. 
 

2. Illustrations 
The Illustrations button group will add images, Smart Art and Clip Art to the spreadsheet.  
 

3. Apps 
This can be used to add additionally functionality to Excel.  
 

4. Charts 
Each button in the Chart group will display a menu of possible charts belonging to the chart type 
represented by the button. There are a number of different column charts that can be chosen, 
including, line charts, pie charts, bar charts, area charts and other charts.  
 

5. Reports 
The Reports chunk contains the Power View. Power View is an interactive data exploration, 
visualization and presentation experience that encourages intuitive ad-hoc reporting. 
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6. Sparklines 
Sparklines are a smaller type of information graphic that show trends and variations in data. 
There are Line, Column and Win/Loss Sparklines. 
 

7. Filters 
Filters are used to filter data in a range or table to show/hide specific data. 
 

8. Links 
The Hyperlink button adds a hyperlink to the spreadsheet. This feature can link to a web page, 
an e-mail address, a file or another location in the same spreadsheet or workbook. 
 

9. Text 
The Text group provides buttons for adding text boxes, headers and footers that will be visible 
on printed documents. 
 

10. Symbols 
The Symbols chunk contains commands to add equations or symbols to the sheet. 
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 The Page Layout Ribbon 

 
 

1. Themes 
The Themes group is used to change colors, fonts and other visual effects associated with a 
given Excel theme. 
 

2. Page Setup 
The Page Setup group lays out a workbook’s pages for printing. 
 

3. Scale to Fit 
The scale to fit group of controls will shrink or scale a printed output to fit on a specified number 
of pages.  

 

4. Sheet Options 
The Sheet Options group adds or removes the gridlines and/or headings from a printout or from 
the Excel screen. 
 

5. Arrange 
The Arrange group is used to arrange various objects (such as shapes, images or other graphic 
elements) in the spreadsheet. This can be used to change the alignment, center and adjust the 
positions of the objects in the spread sheet to obtain the look or desired effect. 
 

 The Formulas Ribbon 

 
 

1. Function Library 
The Functions library has pre-set functions which are mathematical formulas or algorithms 
designed to perform a specific task. Excel 2013 provides a large library of functions designed to 
solve a variety of problems. 
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2. Defined Names 
In Excel, individual cells or groups of cells can be given names. In many cases it is easier to refer 
to a group of cells by a name given to them, rather than some abstract cell reference like A6:B12 
(meaning all of the cells from A6 to B12). 
 

3. Formula Auditing 
The Formula Auditing group can help track chains of cell references and find formula errors. 
These buttons are useful for correcting complex formulas that have hard to find errors. 
 

4. Calculation 
The main part of the Calculation Ribbon is the Calculation Options button which shows options 
for how Excel 2013 will calculate the data in a workbook. 
 

 The Data Ribbon 

 
 

1. Get External Data 
The Get External Data group provides tools for importing data into Excel from other sources 
such as a database, a web page or a text file. 

 

2. Connections 
When a spreadsheet depends on data from external sources, it may be necessary to periodically 
update or refresh the data so the data in the spreadsheet reflects any changes to the data in the 
external sources. The Connections group can help do this. 

 

3. Sort and Filter 
The Sort and Filter group gives finer control over how the spreadsheet data is sorted or filtered. 
Sorting is the process of ordering data based on some criteria, while filtering is the process of 
extracting data from a larger group based on some criteria.  

 

4. Data Tools 
The Data Tools group provides even more features for controlling and manipulating spreadsheet 
data. 

The Text to Columns button arranges a large uninterrupted block of text into individual data 
elements stored properly in columns. This can be a useful feature to cut and paste data into 
Excel from another program. 
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5. Outline 
The Outline group organizes rows and columns of data into groups that can be collapsed or 
expanded. This is useful for large spreadsheets to temporarily hides data that is not important, 
or for reducing the size of a printout when only certain data elements are required. 
 

 Review Ribbon 

 
 

1. Proofing 
The Proofing group contains the Spelling button, as well as the Thesaurus and Research. 

 

2. Language 
The Language chunk contains the Translate button used to translate the document or parts of 
the document to another language. 
 

3. Comments 
The Comments group adds comments and explanations to the spreadsheet as needed. 
 

4. Changes 
The Changes group helps guard against unwanted data modification and to track changes made 
to a workbook that is shared with others. 
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Chapter 3 Excel Basics 

 Moving Within the Document 

To move around the sheet and issue commands with the keyboard, the mouse, or both.  The list below 
describes common keyboard movement keys: 

 
To move using the keyboard: 

,,, Move the cell pointer from cell to cell. 

CTRL+, Moves up or down to the edge of the current data region. 

CTRL+, Moves left or right to the edge of the current data region direction of 
the arrow. 

PGUP Use the PGUP (Page Up) key to move the sheet up one screen. 

PGDN Use the PGDN (Page Down) key to move the sheet down one screen. 

ALT+PAGE DOWN Moves right one screen. 

ALT+PAGE UP Moves left one screen. 

Ctrl+PGDN To move to the next sheet. 

Ctrl+PGUP To move to the previous sheet. 

Ctrl+HOME To move the cell pointer to the upper left-hand corner of the sheet (A1). 

Ctrl+END To go to the lower right-hand corner or edge of the last data region. 

HOME Moves to beginning of the row. 

End+, Move by one block of data within a row. 

End+, Move by one block of data within a column. 

 
To scroll/move using the mouse: 

Click On any cell to move the cell pointer. 

Up Scroll Arrow Scrolls the screen up a line at a time. 

Down Scroll Arrow Scrolls the screen down a line at a time. 

Click on the Scroll Bar Below the Scroll Box Scrolls down a screenful at a time. 

Click on the Scroll Bar Above the Scroll Box Scrolls up a screenful at a time. 

Click and Drag the Scroll Box Scrolls to any location in the document. 

 

 Selecting Cells and Ranges 

Selecting a cell or range can be completed by: 
 
To select any cell: Click on the desired cell or use the arrow keys to move the pointer.  

To select a row:  Click on the border row number. 

To select a column:  Click on the column letter. 

To select the entire worksheet:  Click in the top left hand corner of the border area. 
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To select a range: 
There are three methods to select ranges: 

 Click on and select the first cell of the range then drag the mouse pointer (thus 
extending the highlight) to the end of the range; 

 Click on the first cell of the range then move the mouse pointer, and while holding 
the Shift key, click on the last cell of the range; 

 Use the keyboard to select a range by holding the Shift key and pressing the arrow 
keys to extend the selection. 

 

 Entering and Editing Data 

I. Entering Data 
There are multiple ways to enter data: 

 Click on the cell (make it the active cell) and enter the information directly into it. What 
is typed will also be displayed in the formula bar. 

 Type text, numbers or formulas into the formula bar and press the Enter key. The data 
or formula typed will be entered into the active cell. 

 

II. Editing Cell Contents 
To edit, either retype the cell entry or use one of three methods to select the Edit function. 
 
To select the Edit function: 

 Press F2 - the Edit key 

 Click on the Formula bar 

 Double-click on the selected cell 
 

When the ENTER key is pressed, the changes become permanent; to undo the changes, press 
the ESC key and Excel will place the original cell entry back in the cell. 
 

 Moving Data 

I. Dragging and Dropping Cells 
To drag and drop cells: 

1. Select a cell by clicking on it. 
2. Move the mouse pointer over one edge of the border. The pointer will turn into a four-

way arrow. 
3. Hold the left mouse button down and drag the cell contents to a new location. 

 
A group of cells selected are outlined by a green border.  A group of cells can be moved in the 
same method. 
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II. Cut, Copy and Paste Cells 
To cut or copy and paste cells: 

1. Right click on the cell(s) and click Cut or Copy from the drop down menu. 
2. Select a destination cell, right click it and select Paste from the drop down menu. 

 
Note: This can be done with multiple cells at one time. 
 

III. Paste Special 
Use the Paste Special to perform operations that may be tedious to perform using other Excel 
tools. 
 
Paste Special does more than just paste data. It uses the values pasted to perform operations on 
the destination cells. 
 
Paste Special can add, subtract, multiply or divide the copied value by selecting the appropriate 
radio button. Choose to paste only values so the formula is not copied but the results are.  
 
To use paste special: 

1. Select a cell. 
2. Right-click on the cell, and choose Copy, giving the cell a flashing border. 
3. Right click on the selected area and choose Paste Special from the drop down menu. 
4. This will display the Paste Special dialogue box. 
5. Make the appropriate selections and press OK. 

 

 
 

 

IV. Insert and Delete Cells, Rows, Columns and Worksheets 
To insert a cell: 

1. Right-click on the cell. 
2. Click Insert. 
3. Use the dialogue box to select the options.   
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To insert a column in a worksheet: 
1. Right-click on the letter at the top of the column. 
2. Click Insert from the drop-down menu. 

 
All of the data to the right of, and including the highlighted column, will be shifted one column 
to the right. 
 
To insert a row in a worksheet: 

1. Right-click on the row number. 
2. Choose Insert from the drop-down menu. 

 
All of the data in the row selected as the insertion point and the data in the rows below will be 
shifted down one row. 

 
To delete rows and columns: 

1. Right-click on the row number or column letter. 
2. Select Delete from the drop-down menu. 

 

 Smart Tags and Option Buttons 

Excel’s Smart Tags and Option Buttons can provide information and actions based on the context of 
what is currently being worked on. 

 

I. Smart Tags 
When working in Excel, buttons sometimes appear based on the context of current actions. 
These buttons will provide a menu of options related to the information currently being 
entered. A Smart Tag is a button that appears in response to information being entered in a 
worksheet. 
 
A small green triangle will appear in the top left corner of the cell. This indicates the presence of 
a smart tag. 
 

Hover over the triangle and an icon will appear.  
 
Move the mouse pointer over the button and a drop-down menu will become available. Click 
the downward pointing triangle (list indicator) and a menu of options will appear. 
 

II. The Error Option Button 
When creating a formula and an error is caused, a small green triangle 
will appear in the upper left of the cell. Click on this triangle and the 
Error option button will appear. This button has a drop-down menu 
that offers options to help resolve the error. 
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 Editing Tools 

I. AutoCorrect 
AutoCorrect can help avoid common spelling mistakes and typographical errors as words are 
typed. Excel keeps a list of common misspellings called AutoCorrect entries. If a misspelled word 
is typed that is in the AutoCorrect list, Excel will replace the mistake with the correct word when 
Enter is pressed. 
 
AutoCorrect also enforces rules such as capitalizing the 
first word in a sentence, capitalizing the names of days 
and correcting two successive capital letters. 

 
To customize AutoCorrect: 

1. Open the Office Menu. 
2. Click Options near the bottom left. 
3. Click the Proofing Tab. 
4. Click Control AutoCorrect Options to customize 

AutoCorrect.  
5. Once complete, press OK. 

 
 

II. Spell Check  
Spell check is an Excel editing feature that can be used to check worksheets for spelling 
mistakes. 

 
To spell check a worksheet: 

1. Click cell A1 to get to the beginning of the sheet. 
2. Click the Spelling button in the left corner of the Review Ribbon. The F7 keyboard 

shortcut can be used for quick access to the Excel spelling feature. 
 

III. Adding Comments 
Sometimes it is necessary to include explanations for data or formulas, especially if a 
spreadsheet is very complex. Comments allow for explanations or definitions when needed in 
the spreadsheet. 
 
If a cell contains a comment, there will be a small red triangle in the upper right corner.  

 
To insert a comment: 

1. Click on a cell to insert a comment. 
2. Click the New Comment button on the Review Ribbon. 

OR 
Right-click the cell and select Insert Comment from the drop-down menu. 
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IV. Find and Replace Formatting 
Excel’s find and replace feature can be used to find and replace a specified format. 
 
 To use find and replace with formatting: 

1. Click the Find & Select button on the Home Ribbon. 
2. Choose either Find or Replace. 
3. Click the Options button to display the options for 

formatting. 
4. Open the drop-down list under the Format button and click Format. 

 

 
 

5. The Find Format dialogue box will open. 
6. From this window, select a Number format from the category list. 
7. Next, make sure that the Replace tab on the dialogue box is selected to show the 

options for choosing a replacement format. 
8. Choose a replacement format in the same way. 
9. Click Replace to replace the unwanted format one cell at a time, or click Replace All to 

perform all of the replacements simultaneously.  
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Chapter 4 Editing a Workbook 

 Modifying Cells and Data 

I. Changing the Size of Rows and Columns 
To change the size of a column: 

1. Place the mouse pointer on the line that divides the column 
letters. 

2. The mouse pointer will turn into a vertical line with a small 
arrow on either side. 

3. Click and drag the mouse left or right to change the size and 
release. 

 
To change the size of a row: 

1. Place the mouse pointer on the line separating the row numbers on the 
worksheet. 

2. The mouse pointer will turn into a horizontal line and an arrow on either 
side. 

3. Click and drag the mouse up or down to change the size and release. 
 

To change the size by numbers: 
1. Click the Format button in the Cells chunk in the Home ribbon. 
2. Click either Row Height or Column Height. 
3. Enter the size of the Row/Column. 
 

 

II. Adjusting Cell Alignment 
To align data within a cell: 

1. Select the cell to align. 
2. Click on the alignment button of choice in the Alignment group on the 

Home Ribbon. 
OR 
Click the indent buttons to adjust the alignment in increments.  

  
To align multiple items: 

1. Select a range of cell by dragging the thick cross mouse pointer. 
2. Click the alignment option on the formatting toolbar. 

 

III. Rotating Text 
Rotated text can make worksheets look better, improve organization and improve readability. 
Rotating text can make viewing or printing a large worksheet easier as column widths do not 
have to accommodate the length of text descriptions. 
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To rotate text: 
1. Select the cell or range of cells to rotate. 
2. Click the Orientation button in the Alignment group on the Home 

Ribbon. 
3. The menu is displayed, choose the option that represents the type 

of alignment desired. 
Or 
Right-click on any cell in the selected range and choose Format Cells from the drop-
down menu. 

4. This will open the Format Cells dialogue box. 
 

IV. Creating Custom Number and Date Formats 
Excel provides a variety of number and date formats to choose from. It is also possible to create 
custom number and date formats in Excel to present data exactly as needed. 
 
To create a custom number format: 

1. Select a cell that contains the number to format. 
2. Right-click on the cell and choose Format Cells from the drop down menu. 
3. Click the Number tab. 
4. Select Custom from the bottom of the category list. A text window containing a list of 

symbolic formatting codes underneath the heading Type will appear. 
5. Click on a symbolic formatting code (what the number will look like with this formatting 

applied to it). 
6. The format code for the custom number format will be saved at the bottom of the 

format code list in the Format cells dialogue box. 
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 Cell Formatting 

I. Conditional Formatting 
A worksheet can be designed in such a way that data is formatted differently, based on the 
values the data assume at any given time. This is called conditional formatting.  
 
To use conditional formatting: 

1. Select a range of data to apply the formatting to. 
2. Click on the Conditional Formatting button on the Home Ribbon. 
3. A menu of conditional formatting options will be displayed. 
4. These options are: 

o Highlight Cells Rules - Highlight cells that are greater than, 
less than, between or equal to values specified. 

o Top/Bottom Rules - Highlight the top or bottom numbers 
or the percent in the selected cells. 

o Data Bars - Display colored bars that are indicative of the 
value in the cell.  

o Colour Scales - Use different shades of color to represent 
different values, from low to high. 

o Icon Sets - Use sets of similar icons that will visually 
indicate a cell’s value. 
 

Note: At the bottom of the menu there are options for creating new rules, for clearing rules, 
and for managing rules. 

 

II. Format Painter 
The Format Painter can format a cell or selection of cells with an existing format from another 
cell. The Format Painter can be accessed from the Home Ribbon.  
 
To use the Format Painter: 

1. Select a cell by clicking on it. 
2. Click the paint brush button on the Clipboard section of the Home Ribbon. 
3. The selected cell will be enhanced with a flashing dark and light border and the mouse 

pointer will turn into a thick cross with a paint brush beside it. 
4. Any cell or range selected with the cross and paint brush pointer will assume the format 

of the cell that the format was selected from. 
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 Enhancing a Worksheet’s Appearance 

I. Adding Patterns and Colours 
To add colors to a worksheet: 

1. Select the range of cells to add colour to. 
2. Click the Fill Color button in the Font group on the Home Ribbon to display the colour 

choices. 
3. Choose shades of colours from the theme currently being used (theme colours) or 

choose from a selection of standard colours. 
4. Hover the mouse over each color in the color menu. The selected cells will be previewed 

in that colour. 
 
To add patterns to a range: 

1. Select a range of cells. 
2. Right-click and choose Format Cells from the menu. 
3. When the Format Cells dialogue box appears click the Fill tab. 
4. Select a colours and/or choose a pattern from the drop down palette.  

 

 
 

II. Adding Borders 
Borders can help separate and distinguish selected data within a worksheet or give a worksheet 
a more polished appearance. 
 
To add a border to a worksheet: 

1. Select a range of data. 
2. Right-click within the range and choose the Border menu. 
3. Select the border type to apply to the range and the borders will be added. 
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 Working with Charts 

I. Creating a Chart 
Excel provides a series of chart buttons and controls on the Insert Ribbon. 
 

 
 
First consider the type of chart that is required. Pie charts and bar charts are good for showing 
comparisons. Line graphs can be useful for showing trends and plotting relationships between 
variables. 
 
To create a chart: 

1. Select the data to base the chart on. 
2. Click the Insert tab to display the Insert Ribbon. 
3. Select the desired chart style. 

 

II. Formatting a Chart 
After a chart has been created, the style can be changed. 

  
To format a chart: 

1. Single click inside the box (chart area) that surrounds the chart 
2. Chart Tools will appear in the Excel title bar.  
 

 
 
3. Clicking on Chart Tools will display the Design Ribbon. (The design Ribbon can be 

displayed by double clicking on the Design tab.) This Ribbon provides a variety of quick 
and easy chart reformatting options. 

 
To format the legend: 

1. Right-click on the chart legend and choose Format Legend 
from the pop up menu. 

2. A Format Legend option menu will appear on the right. 
3. In this dialogue box, select any one of the legend position 

radio buttons to place the legend in the position specified. 
 
Note: The Fill option on the left panel pertains to the legend 

background fill colour. 
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To format the plot area: 
1. Right-click inside the plot area, which is the area of the 

box that is close to the chart itself. A second inner box will 
surround the chart. 

2. Select Format Plot Area from the pop up menu. The 
Format Plot area will display on the right.  

 
 

 
 

To format the chart area: 
1. Right-click on the blank white area of the chart (around 

the heading and legend). 
2. Select Format Chart Area from the pop up menu, this will 

display the Format Chart Area dialogue box. 
 

 
 
 

 

III. Manipulating a Chart 
It may be necessary to resize or even move a chart around the spreadsheet.  
 
To resize a chart: 

1. Single click in the chart area to display the chart area border. 
2. Place the mouse pointer on the corner of the chart border until it turns into a four-sided 

arrow. 
3. Drag the chart corner with the mouse to resize the chart. 
 

To move a chart: 
1. Hover the mouse pointer over one border side. 
2. When the mouse pointer turns into two crossed arrows, drag the chart around the 

screen. 
 
To make a chart an object in another worksheet or move the chart to a sheet of its own: 

1. Right-click on the chart. 
2. Choose Move Chart from the drop down menu. 
3. This will display the Move Chart dialogue box. 
4. Select whether the chart will be moved to a new 

sheet or an already existing sheet. 
5. Click the OK button to move the chart. 

 
To remove a chart from a worksheet: 

1. Click in the chart area. 
2. Press the Backspace or Delete key on the keyboard. 
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IV. Changing the Chart Type 
To change the chart type: 

1. Display the Design Ribbon by clicking on the chart 
area. 

2. Click the Design tab.  
3. Click the Change Charte Type button to display 

the Change Chart Type dialogue box. 
4. Select a new chart type or variation based on the 

data in the existing chart. 
5. Click OK to change the chart type. 

 
 
 
 

V. Changing the Data Source 
Excel makes it easy to change the source data for a chart while retaining the original chart type. 
 
To change the data source for a chart: 

1. Right-click on the chart area. 
2. Click Select Data from the menu that appears.  
3. This will display the Edit Data dialogue box. 
 

 
 

4. The text field labeled Chart Data Range will show the range of cells that serve as the 
current data source for the chart. 

5. To change the data source, use the mouse to select the new data range from the 
spreadsheet.  

6. As this is being completed, the new range will be entered into the data source field. 
7. When complete, the new data range will be in the Edit Data Source dialogue box. 
8. Click OK in the lower right of the box. 
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VI. Working with the Chart Axis and Data Series 
In a typical chart, the axes are the horizontal and vertical scales that are used to coordinate the 
data. Data is charted with respect to its numerical position along an axis. 
 
A series is a group of data (normally a selection of cells) that is to be charted against an axis. 
 
More than one series can be represented in a chart to show how the different series (selections 
of data) compare to each other. 
 
To add more than one series to a chart: 

1. Right click on the chart. 
2. Click Select Data from the menu that appears.  
3. This will display the Select Data Source dialogue box. 
4. To add a new series to the chart click the Add button.  
5. This will display an Edit Series box. Enter a name for the 

series. 
6. Next, enter a range of data for the series by dragging the 

mouse pointer to select a range from the spreadsheet. 
7. Click OK on the Edit Series dialogue and then on the Select 

Data Source dialogue. 
 

To format an axis: 
1. Right-click on one of the values on an axis 
2. Choose Format Axis from the drop-down menu 
3. This will display a Format Axis dialogue box on the right. 
4. In this box, there are controls to specify the units and adjust the scale, 

tick mark, and position of the Axis labels. 
5. If a different heading is selected from the panel (the heading 

highlighted in this image is Axis Options) the line style of the axis, the 
shadow and other aspects of its format can all be changed. 

 
To change the labels on an axis: 

1. Right-click on the chart. 
2. Click Select Data from the menu. 
3. Click on the edit button in the Axis Labels area of the dialogue box.  
4. An Axis Labels box will appear. 
5. Select the labels desired from the spreadsheet by dragging the mouse 

to select the appropriate cells or manually type the cell range into the box provided. 
6. Click OK. 
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To quickly change a chart layout: 
1. Use the Chart Layout buttons available on the Design Ribbon. 
2. Apply numerous layouts to a chart by clicking the different layouts.  

 
 
 
 
 
 

 

 Basic Excel Features 

I. Autofill 
Excel’s AutoFill feature can help enter repeated or incremental text or numbers quickly. AutoFill 
enters consecutively increasing or decreasing values in adjacent cells by whatever increment is 
defined between the first two selected cells.  
 
To use Autofill: 

1. Enter data in two cells in the column that will be Autofilled. 
2. Select both cells. 
3. Place the mouse pointer over the small black square in the lower right 

corner of the selection, the mouse pointer will turn into a thin cross. 
4. Hold down the left mouse button and drag the + pointer down the 

column, a small comment box will appear show what AutoFill is putting 
in each cell. 

 
Note: If only one cell is selected, that cell will be duplicated the contents of that cell into the 

others. 
 
 

II. AutoSum 
AutoSum can easily add all of the numerical data in a column or row.  
To use AutoSum: 

1. Click on the cell immediately below the column of data (or immediately beside the row 
of data). 

2. Click the Formulas tab and then click AutoSum button. 
3. The column or row of data to be summed will now be enhanced by an animated border 

and the range to be summed in the active cell. 
4. Press Enter and the total will be displayed in the cell. 
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III. AutoComplete 
AutoComplete helps enter data by completing what is being typed, based on similar data in 
adjacent cells in the same column. Press Enter to accept the substitution that is suggested. 
 

IV. Sorting Data 
Sorting and Filtering allows information to be arranged by a specific value or custom criteria.                                     

 
Sorting to arrange the text: 

1. Select the column of data to sort.  
2. From Home Tab, find the Editing section and click the Sort & Filter Button. 
3. Choose the desired sort. 

 

V. Filtering Data 
 Filtering data, text, dates, etc. allows only the rows with specific criteria to display. 

 
 To filter data: 

1. Select the group of cells to filter. 
2. From the Home Tab, under the Editing section, click the Sort and Filter 

button, then Filter. 
3. Open the drop-down menu to access the filter criteria settings. 
4. Select the numbers to filter by checking the boxes next to the values.  

 
To customize a filter, select the column to apply the filter to by clicking on the arrow and then 
Filters. Select Custom Filter. 
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Chapter 5 Working with Function and Formulas 

 Using Formulas in Excel 

Excel has functions and formulas that can be applied to data. When data is entered or changed, the 
Excel worksheets are automatically recalculated based on the mathematical formulas and functions that 
are connected to the data.  

 

I. Understanding Relative and Absolute Cell References 
In Excel, a specific cell can be named or referred to with a cell reference. A simple cell reference 
is just the letter at the top of the cell’s column, paired with the number at the left of the cell’s 
row. Cell A1, for example, is the first cell in the top left corner of the Excel grid (first column 
letter, A, and first row number, 1). 
 
The first rule of formulas is that all formulas must begin with an equals sign. This tells Excel that 
what follows is a formula. 
 
A relative cell reference means that if the formula is moved (dragged, filled, or copied) the cells 
involved will change to reflect the formula’s new position. 
 
An absolute cell reference is where the formula contains dollar signs. These dollar signs tell 
Excel that the references in the cell are absolute: no matter where the formula is copied or filled 
to, it will always use the same cell references.  
 
To summarize, a reference like A1 it is a relative cell reference because there are no dollar signs 
included. The cell reference $A$1 is an absolute cell reference, because of the dollar signs in 
front of the letter and number. The cell reference $A1 has an absolute column reference 
(because the column letter has a dollar sign in front). In this case, the column reference will 
never change. The cell reference A$1 has an absolute row reference, meaning the row reference 
will never change. 
 
To copy or fill a formula across cells, and want the cells in the formula and the result of the 
formula to change relative to locations, use relative references. 
 
To copy or fill a formula across cells, and want the specific cells used in the formula to remain 
the same, use absolute references. 
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II. Basic Mathematical Operators 
 
To build formulas in Excel, use the basic mathematical operators as shown in the following 
table: 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
These operators are listed from top to bottom in order of precedence. This means that the 
following expression, 3*2+4, will have the answer 10. This is because 3*2 is evaluated first, and 
then 4 is added (multiplication takes precedence over addition). 

 
Order of operations can be defined by enclosing expressions in parentheses (). The operations 
inside the parentheses will be evaluated before the operations outside. If there are parenthesis 
within parenthesis as in ((2+3)*4), the expression in the inner parentheses, (2+3) =5, will be 
evaluated first, and the result will be used to evaluate the expression in the outer parentheses, 
(5 *4) =20. 
 

III. Using Formulas with Multiple cell References 
In the below spreadsheet there are the following columns: Items Sold, Price, Total, Sales, Cost 
per Item, Overhead and Profit. 
 

 
 
To come up with a figure for the profit column, the total sales must be evaluated (items sold 
multiplied by the price per item) and the total expenses (items sold multiplied by the cost per 
item, and then Overhead added). 
 

^ Exponent   ( 10^2 = 100) 

* Multiplication ( 10*2 = 20) 

/ Division     (10/2 = 5) 

+ Addition      (10+2 = 12) 

- Subtraction   (10-2 = 8 ) 

=  Equivalence 

> Greater than    ( 10>2 ) 

< Less than     ( 2<10 ) 
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To do this, click on cell D2 and enter =B2*C2 in the formula bar. Drag this formula to fill cells 
D2:D7, the total sales for each location will be calculated. 

 
Profit is the total expenses subtracted from the total sales. In this instance, the total expenses 
for the row labeled Region1 would be B2*E2+F2 (items sold * cost per item + overhead). 
Remember, the total sales is in column D, so enter =D2-(B2*E2+F2) into cell G2, and then fill 
down to G7, the profit column will be completed. 
 

 
 

IV. The Formula Auditing Button 
Excel provides some great features for working with formulas in the formula auditing button 
group. To display these buttons, click the Formulas tab to show the Formulas Ribbon. The 
formula auditing buttons can help trace errors and show wchich cells that are referenced in a 
formula. 

 
 

 
Trace Precedents button Displays blue arrows to cells that supply data to the formula 

(arrows may be red if a supplying cell has an error). 
 

Trace Dependents 
button 

Displays arrows to the other cells that depend on a given cell’s 
data. 
 

Remove Arrows button Removes both precedence and dependence arrows from the 
Excel screen. 
 

Show Formulas button Toggles between showing results and formulas in the worksheet. 
 

Error Checking option Checks the entire worksheet for formula errors. If any are found, 
there will be an alert with an error checking dialogue that 
pertains to the specific error in question. 
 

Trace Error Displays arrows to the cells referenced in an incorrect formula. 
 

Evaluate Formula Helps analyze, interpret, and correct formulas. 
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V. Fixing Formula Errors 
Formulas in Excel can range from simple to complex. When entering formulas, there are a 
number of mistakes that can be made, like leaving out a parenthesis or referencing the wrong 
cells. When a long formula with several cell references and doesn’t work, pinpointing the error 
can be difficult.  
 
A good first step in fixing formulas is learning to understand Excel’s error messages. A number 
sign (#) followed by some text, rather than the expected result, indicates the formula contains 
an error. 
 

 
 

 

#NAME? Something in the formula that Excel interprets as an incorrect cell 
reference, range or function name. 

#REF!  A cell in the formula may have been relocated or deleted. 

#VALUE!  Text is contained in a formula when another argument (probably a 
number) is required. 

#DIV/0!  A number is divided by zero or divided by a reference to an empty 
cell. Division by zero is mathematically undefined. 

#NUM!  An incorrect argument is passed, like text, to a function that is 
expecting a numerical value. 

#######  A number is too wide to be displayed in the cell. Double-click the 
column separator to resolve this error. 

 
To fix formula errors: 

 Make sure that the cell with the message is the active cell and carefully examine the cell 
contents in the formula bar. 

 Use the formula auditing buttons to trace the precedent cells or dependent cells of the 
formula in question.  

o When these cells are located, examine them for typing mistakes or incorrect cell 
references.  

o Examine the error message carefully to understand what to look for (i.e. division 
by zero or text being used in an equation). 

 Examine the contents of every cell involved in the formula to make sure that the data 
types (number, text) are appropriate.  
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A formula can still have an error even if there is no error message. The formula may produce a 
numerical result as expected, but the result is incorrect. If this happens, examine the 
mathematics of the formula. Are the parentheses in the right places? Are the right functions 
being used? Are the right mathematical operators being used?  

 
Avoid errors by planning out long and complex formulas before entering them. 

 

VI. Displaying and Printing Formulas 
By default, Excel shows the results of a formula rather than the formula itself in a cell. 
 
The formula is visible in the formula bar but only the result are shown in the cell containing the 
formula. If this worksheet is printed, only numerical results will be shown in the cells and not 
formulas.  
 
To display formulas when printing: 

 Display the Excel Options window by clicking the Excel Options button under the Office 
menu. 

 In the Excel Options window, click the Advanced option from the panel on the left 

 Use the scroll bar to scroll the large viewing area on the right down to the Display 
Options for this Worksheet. 

 Check the “Show formulas in cells instead of their calculated results” option. 
 

The Show Formulas button on the Formula Auditing button group can also be used. If the 
spreadsheet is printed with this active, the formulas will be printed in the cells instead of the 
formula results. 
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 Exploring Excel Functions 

Functions are an important feature in Excel. They allow for complex or tedious mathematical tasks 
without having to create elaborate formulas. Excel’s built in functions can do a lot of heavy calculation 
and data manipulation. Excel has such a wide variety of functions available, an appropriate function or 
combination of functions can be used for almost any situation. 

 

I. What are Functions? 
In Excel, a function can be described as a built in tool for performing mathematical or logical 
tests.  
 
Operations that are complex and involve many cell references can be difficult or even 
impossible to implement with basic arithmetic formulas. Excel provides a wide range of built in 
functions that help make complex or repetitive calculations easy. 

 
All of the functions listed below and more can be accessed from the Function Library button 
group on the Formulas Ribbon. 
 

 
 
Excel’s functions are broken down into the following categories. Under each heading is a list of 
some of the more common functions that belong to that category. 
 
1) Financial Functions 
These functions perform common financial tasks, like finding future values, calculating loan 
payments, calculating depreciation and finding interest paid over a time period. 

 
2) Date and Time Functions  
These functions provide representations and conversion options for dates and times. Listed 
below are commonly used Date and Time functions: 
 

DAY  Returns the number of the day from 1 to 31. 

DAYS360  Calculates the number of days between two dates based on 360 day 
years. 

NOW Gives the current date and time. 

TIME   Converts hours minutes and seconds to an Excel serial number time. 

TODAY   Provides the current date. 
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3)  Mathematical and Trigonometric Functions 
These functions are intended for mathematical calculations that can involve logarithms, 
trigonometry, rounding or matrices. Listed below are the commonly used Mathematical and 
Trigonometric Functions: 
 

ABS    Gives the absolute value of a number. 

CEILING  Rounds a number up to the nearest integer. 

EVEN  Rounds a number up to the nearest even integer. 

INT  Rounds a number down to the nearest integer. 

ODD  Rounds a number up to the nearest odd integer. 

POWER   Raises a given number to a given power. 

PRODUCT   Multiplies a series of numbers. 

RAND  Generates a random number between 0 and 1. 

ROUND   Rounds a number to a specified number of digits. 

ROUNDDOWN   Rounds a number down. 

ROUNDUP  Rounds a number up. 

SIGN  Will indicate if the number is negative positive or zero. 

SUBTOTAL   Gives the subtotal for a list of data. 

SUM  Calculates the sum for a range of cells. 

SUMIF  Calculates the sum of cells that satisfy a given condition. 

TRUNC   Truncates a floating point number to an integer. 
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4) Statistical Functions 
Excel has a wide range of statistical functions including many that have been improved from 
previous versions. These functions find averages, counts, medians, probabilities, standard 
deviations, etc. The following is a sample of some of the more common statistical functions in 
Excel. 
 

AVERAGE   Returns the mean for a range of numbers. 

AVERAGEA Returns the mean for a range of values that might include text 
or logical values. 

COUNT   Will count the number of cells in a list that contain numbers. 

COUNTIF  Will count the number of cells in a list that satisfy a specified 
condition. 

MAX  Returns the largest number from a range of numbers. 

MAXA   Finds the largest value in a set of values that may include text or 
logical values. 

MEDIAN  Finds the median of a range of numbers. 

MIN Finds the minimum number in a range of numbers. 

MINA   Finds the minimum number in a range of numerical, text, or 
logical values. 

MODE   Gives the most frequently occurring number in a set of 
numbers. 

PERCENTRANK  Gives the rank of a number as a percentage of the numbers in 
the range of data. 

RANK   Gives the rank of a number relative to the other numbers in the 
dataset based on size. 

STDEV   Gives an estimate of the standard deviation based on a sample. 

STDEVP   Calculates the standard deviation for an entire population. 
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5) Lookup and Reference Functions 
The lookup and reference functions can help gather information about cell ranges and 
references and determine the location of specific data elements in a range. Some of the more 
important lookup and reference functions are: 
 

ROW  Finds the row number for a given reference. 

ROWS  Shows the number of rows in a given range. 

VLOOKUP  Finds a specified value in the far left column of a table and 
returns from the same row, a value from a column specified. 

 
6) Text Functions  
Text functions help manipulate individual characters and strings of characters that are entered 
in a worksheet as text. Some useful text functions are: 
 

CLEAN  Removes all characters that cannot be printed from the text. 

CONCATENATE  Joins together strings of text into one larger string. 
 

 
7) Logical Functions 
The logical functions allows for logical tests and to build logical expressions based on the 
arguments provided. This can be used test conditions and proceed according to the result. 
 

AND  Returns the logical value true if all of the arguments specified are 
true, and will return a logical value of false otherwise. 

FALSE  Returns the logical value false. 

IF  Tests if a condition is true, and returns a specified value if it is, and 
another specified value if it is not. 

NOT  Changes logical values from true to false or false to true (not true 
is false, and not false is true). 

OR  Returns a logical value of true if any of the arguments are true and 
a value of false if both or all arguments are false. 

TRUE  Returns the logical value of true. 
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II. Finding the Right Function 
In Excel, use the Insert Function dialogue box to help find the function needed for a given 
situation. 
 
The Insert Function dialogue box can be displayed by clicking the Insert Function button from 
the Function Library button group. 

 

The small  button next to the formula bar can also be used to display the Insert Function box. 

 
 
The Insert Function box has a drop-down list of function categories next to the words Select a 
category. When a category has been selected for a given situation, a list of possible functions 
will be displayed in the Select a Function area.  
 
When a function is selected, an example of the function and its parameter list will be visible in 
bold near the bottom of the dialogue box. There will also be a brief description of the function 
that has been selected. For additional help on using the selected function, click the blue text link 
(Help on This Function) to open a help window with more links and information. 
 
If no single function that works, consider combinations of functions. Perhaps an average of sums 
or a maximum of averages is required. If need be, include and combine functions with formulas. 

 
 

III. Some Useful and Simple Function 
 
It is a probably a good idea to become familiar with some basic but useful Excel functions.  

 
1. SUM function  

Use the SUMIF function to add all the numbers in a column or row that meet a certain 
condition. 

 
2. AVERAGE function 

To find the average of monthly profits, select a cell (like B28) and enter =AVERAGE (C2:B25) 
in the formula bar. This will compute the average salary and display it in cell B28. 

 



42 | P a g e  Excel Level 1 • 2018 University of Regina 

3. MAX function 
The Maximum function will give the highest value in a range of cells. It follows the same 
format as the others. Position the cell pointer in the cell where the answer will appear.  Enter 
the formula =MAX(first cell:last cell). Press ENTER. 

 
4. MIN function 

The Minimum function follows the same format as the Sum function.  This function is used to 
find the lowest value in a range of cells. Position the cell pointer in the cell where the answer 
will appear. Type in the formula =MIN(first cell:last cell). Press ENTER. 

 
5. COUNT function 

The Count function counts the number of cells that contain numbers within the list of 
arguments.  Use COUNT to get the number of entries in a number field in a range. Position 
the cell pointer in the cell where the answer will appear. Enter the formula =COUNT(first 
cell:last cell). Press ENTER. 

 
6. COUNTA function 

The COUNTA function counts the number of cells that are not empty and the values within 
the list of arguments. Use COUNTA to count the number of cells that contain data in a range.  
Position the cell pointer in the cell where the answer will appear. Enter the formula 
=COUNTA(first cell:last cell). Press ENTER. 

 
7. COUNTBLANK function 

The CountBlank function counts the number of cells that are empty. Use CountBlank to count 
the number of cells that do not contain data in a range. Position the cell pointer in the cell 
where the answer will appear. Enter the formula =COUNTBLANK(first cell:last cell). Press 
ENTER. 
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IV. Using AutoCalculate 
AutoCalculate is an Excel feature that shows the results of some basic calculations without 
having to enter a formula or function. This can be used for quick calculations that will not be 
entered into the worksheet or for troubleshooting simple formula errors. 

 
To use AutoCalculate: 

1. Select a range of cells with numerical data. 
2. The Sum, Count and Average of the selection can be seen in the status bar at the 

bottom of the Excel screen. 

 
 
To change AutoCalculate options: 

1. Right-click on the status bar and a menu will appear. 
2. Place a check mark next to the calculations that AutoCalculate will perform when a 

range is selected. 
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Chapter 6 Printing and Viewing a Workbook 

 Using the View Ribbon 

In Excel there are a few different ways to view a workbook. These different views are designed to make 
certain tasks easier. 
 
The options for the different Excel views can be found on the View Ribbon. 

 

I. Using Normal View 
 
The normal view displays the user interface ribbon, the quick access toolbar, the Ribbon tabs, 
the status bar at the bottom and a reasonably large part of the Excel cell grid. This view is best 
suited for general work in Excel as it provides easy access to many controls and features, as well 
as the working area (grid). 

 
On the View Ribbon, the Normal view is currently selected. There are several other view 
options. 
 

 
 
There are checkboxes for Gridlines, Formula Bar and Headings on the View Ribbon. 
 

 
 
Clearing these checkboxes will cause the formula bar and gridlines to disappear from Excel 
screen. 

 
There are also a group of buttons in the lower right of the screen on the status bar. Use these 
buttons to quickly switch between workbook views. 
 

 
 
Starting at left, the first button will switch to Normal view. The second button will switch to 
Page Layout view, and the third button will switch to Page Break preview. 
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II. Using Page Layout View 
Page Layout view shows the boundaries of the printed pages, almost like a print preview. The 
difference is that this view provides all of the Excel functionality that is available in any other 
view. 

 
To get to Page Layout view: 

1. Click the Page Layout button in the Workbook Views button group on the View Ribbon.  
2. This displays the spreadsheet in page layout view. 

 
To add headers and footers to printed pages: 

1. Click on the page right where it says Click to 
add header. 

2. Enter a header for the printed pages. The 
situation is the same for footers. 

 
 

III. Page Break Preview 
The point where one continuous sheet of data is broken into separate pages is a page break. If 
an Excel worksheet that is too big for a single page is printed, Excel will define page breaks 
based on the size of the cells, the size of the paper and the print scale chosen.  
 
On a large worksheet, the data can be broken into pages in awkward, illogical ways. To avoid 
this, it is important to learn how to manage page breaks. 
 
To manage page breaks: 

1. Click the Page Break Preview button on the View Ribbon 
2. This will display an Excel view that shows page breaks in the spreadsheet as blue dotted 

lines. The solid blue lines indicate the boundaries of the printed page. 
3. The Page Break view does provide functionality. 
4. To change a page break, drag the blue dotted lines with the mouse to adjust where one 

page ends and another begins. 
 

 Managing a Single Window 

When a workbook is opened in Excel, the actual working area (grid area with column letters and row 
numbers), is defined as its own region. The working area is bounded by a border and can be minimized, 
closed or resized independently of the Excel program itself. This self-contained working area can be 
referred to as a window. 
In Excel, there can be multiple windows of the same workbook 
open at the same time. There can also be multiple windows of 
different workbooks open at the same time. The different window 
buttons are shown below. 
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I. Creating a New Window 
To create a new window in a workbook: 

1. Display the View Ribbon 
2. Click the New Window button. 
3. A new additional window for the same workbook will be created. 

 

II. Hiding a Window 
To hide a window: 

1. Click the Hide button on the View Ribbon 
 

III. Unhiding a Window 
To unhide a window: 

1. Click the Unhide button on the View Ribbon. 
2. An Unhide box will appear showing any windows that have been hidden. 
3. Select the window in the unhide box and click the OK button. 

 

IV. Freezing a Pane 
It is sometimes convenient to be able to keep one part of a spreadsheet viewable while 
simultaneously viewing other parts of the same spreadsheet (for example, keeping cells with 
headings in place while scrolling through the data). 

 
To use freeze: 

1. Open a workbook window. 
2. Click the Freeze Panes button on the View tab to display a menu of freeze options. 

 
 
To unfreeze cells: 

1. Click the Unfreeze Panes option that appears on the Freeze Panes menu. (This menu 
item will only appear whenever panes are frozen.) 

 
To use a split: 

1. Select a single cell. 
2. Click the Split button. 
3. The window will break into four panes around the selected cell. The four scroll bars 

allow for each pane to be viewed independently. 
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To equally split the four sections select A1 before splitting. 
 

To remove Split: 
1. Click the Remove split button. 

 

 Printing a Workbook 

There are a few other Excel features that are helpful when printing documents. 
 

I. Opening Print Preview 
To open print preview: 

1. Open the Office Menu. 
2. Click Print. 
3. The Print Preview will be displayed on the right side. 

 
 
 

II. Printing Options 
To print multiple sheets in a workbook: 

1. Activate the multiple sheets, by clicking the tab for the first sheet 
2. Hold down the Ctrl button while clicking the tabs for the other sheets to print. 
3. In the Print dialogue box select the Active Sheet(s) option and the active sheets will be 

printed. 


